CONTRACTED PROVIDER INVOICE TRAINING
PRESENTERS

- Gabe Kieffer  
  OR-Kids Business Analyst (Financials)  
  (Work) 503-269-9003  
  gabe.w.kieffer@state.or.us

- Suzanne Whelan  
  Child Welfare Contract Support  
  (Work) 503-945-5971  
  suzanne.whelan@state.or.us
INTRODUCTIONS

WHY THE CHANGE?

DEMONSTRATION/DISCUSSION OF INVOICE

WHAT HAPPENS WHEN I SUBMIT?

TROUBLESHOOTING/COMMUNICATION

PAYMENT

QUESTIONS
Current Challenges

Current process:

- Timely payment to contracted providers is inconsistent.

- Providers do not receive standard, dependable communication advising on the status of their payment.
Contracted Invoice Validation Process (Current)

Provider:
Provider Submits Invoice

Field Staff:
Invoice Received. Communication between providers and branch is inconsistent.

Contracts Payable:
Branch submits invoice to OFS for payment.

OFS Receives and pays all available lines. OFS communicates with branch staff if experiencing issue. OFS currently finds many lines are validated as ready to pay but are not.

Payment to Provider. Payment may take up to 45+ days to occur.
GOALS

- **Improving Business Practice**
  - Provider experience with DHS processes should be consistent statewide.
  - Efficiency (avoiding mistakes and re-work).

- **Improved Communication**
  - At each stage in the current process, the process will support clarity and reduce confusion.

- **Improved timeliness of payment and provider satisfaction.**
  - Providers, when submitting their invoice, will be confident regarding a timeframe for payment.
Contracted Invoice Validation Process (New)

Provider
- Provider Submit Invoice

Field Staff
- Invoice Received. Automated message sent to provider to confirm invoice receipt.
- Branch-Level Invoice Validation occurs within 5 business days. Any issues with invoice that provider can clarify are communicated. Any lines that are denied for payment are communicated.
- Branch submits invoice to OFS for payment. CC’s the provider to advise invoice has moved forward. Staff continue working on any held lines.
- Branch staff work held items until cleared. Send email to OFS to confirm payment is authorized. CC provider.

Contracts Payable
- OFS receives and pays all available lines. OFS communicates with branch staff/returns invoice (CC’s provider) if experiencing issue.

Payment to Provider.
What’s New

- New Standard Electronic Invoice (Required).

- Branch-Level Email solutions to simplify submission and communication between staff and providers.

- Updated Websites for Providers and DHS Staff.

- Enhanced steps/tools to improve communication and tracking of invoices and issues.
  - Hold Tracking Worksheet/Reference Guide

- Focus on keeping invoice document in electronic form and avoiding printing/scanning!

- Expectation that branch validation and submission to OFS will occur within 5 business days whether all lines approved or not.
NEW INVOICE
**NEW INVOICE (CF846)**

### DHS Contract Invoice

**Payee information**

<table>
<thead>
<tr>
<th>Provider number:</th>
<th>Contact email:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider name:</td>
<td>Invoice number:</td>
</tr>
<tr>
<td>Provider address:</td>
<td>DHS branch:</td>
</tr>
<tr>
<td>Street, City, State, ZIP</td>
<td>Billing month/year:</td>
</tr>
<tr>
<td>Provider contact:</td>
<td>Phone:</td>
</tr>
</tbody>
</table>

**Provider signature**

**Date**

**DHS signature**

**Date**

**Date received by DHS branch:**

**Sync invoice**

**Add a Row** | **Copy a Row** | **Delete a Row** | **Reset Row**  

**Freeze & Scroll** | **Unfreeze Rows** | **Caseworker Sort** | **Case Number Sort** | **Contract Number Sort**

**Line #** | **Contract number** | **Caseworker name** | **Case number** | **Foster provider/ Subcontractor** | **Participant name** | **Participant number** | **Service category** | **Service type** | **Service start date** | **Service end date** | **Rate per unit** | **Number of units** | **Invoiced amount** | **Service Outcome** |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$0.00</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Notes (DHS use only):**

**Svc auth:**

**Validation code:**

**Validation date:**
Completely electronic! No need to print, scan or .pdf!

Separate tabs for Fee-for-Service and 1/12th contracts

Instructions provided on Tab 3 for providers and staff.

Cool Functions!
- It Locks!
- Sort by Caseworker!
- Sort by Case!
- Sort by Contract!
- Copy and add rows easily to reduce work.
- Sync feature facilitates communication over the phone.
- Color-Coding for Validation Decisions!
- Service outcome tracking!

Provider signature is not required.
- Providers may invoice multiple contracts on a single invoice (Exception: 1/12th contracts).

- Providers are requested to invoice per month and per branch (e.g. Only Payments for Marion for September on a single invoice). Combining payments for multiple months or branches will cause a delay for OFS Contracts Payable.

- One Time Payments do not need to be submitted separately, and can be invoiced along with all other transactions for the provider.

- Providers are requested to complete all fields on the invoice.

- Providers do not enter amounts on the 1/12th Invoice.

- Providers will submit the invoice in a locked format.
NEW INVOICE: PROTECTION

Password Protection:
Your password is your DHS Provider Number.

MS Excel 2003:
File>Save As>Tools>Options>Password to open: Enter DHS Provider #>OK>Reenter password at prompt>OK>Save>Close

MS Excel 2007:
Microsoft Office Button>Prepare>Encrypt Document>Enter DHS Provider #>OK>Reenter password at prompt>OK>Save>Close

MS Excel 2010:
File>Info>Protect Workbook>Encrypt with Password>Enter DHS Provider #>Save>Close
Compatibility/Limitations:

- The sort and sync functions of the invoice are **inoperable with MS Excel 2003** and earlier, along with Microsoft Office Online products.

- These earlier versions are not recommended, as they are no longer supported by Microsoft and pose a security risk (Microsoft Office 365 can be obtained for $99/year for 5-user version).

- MS Excel 2003 and earlier versions **STILL** allow the other functionality to be utilized, and can still be used to enter and submit payment requests.

- Remember that submitting your invoice using the standardized Excel invoice, and submitting it as an Excel file **will be critical** in helping us expedite your payments.
How can I get the invoice?

The invoice will be available on the new provider page: http://www.oregon.gov/dhs/children/providers-partners/Pages/index.aspx

Is any training available for this document or process?

Yes! We’ve created a Computer Based Training (CBT), which can be accessed on the new Provider Page:

The CBT offers:

- Section by Section instructions on completion of the document.
- Table of Contents feature that allows quick access to relevant information
- 24/7 availability on the web.
“We are what we repeatedly do. Excellence, then, is not an act, but a habit.” – Aristotle

- **Branch-Level Emails** *(see hand-out)*

- Providers, many of whom operate statewide or interact with multiple districts/branches, should expect to receive consistent treatment across all contacts with DHS.

  - Pre-formatted email addresses and responses.

  - Providers will no longer have to worry if they’re contacting the correct person.

  - DHS will no longer have to constantly update the list of validation staff.
FOLLOWING INVOICE SUBMISSION
DHS Invoice Validation staff are expected to complete an initial validation process within 5 business days of receipt, then submit to OFS and continue working held lines.

DHS Office Managers are expected to ensure coverage for the contract-invoice email inbox on every business day.

Staff have been trained that they are to immediately contact providers by phone or email when questions arise about a submitted invoice.

Staff have been explicitly instructed NOT to return an invoice unless it completely fails to provide sufficient information for validation AND the provider does not respond timely to requests to clarify.
NEW: PAYMENT/HOLD CODES

<table>
<thead>
<tr>
<th>Line</th>
<th>Contract number</th>
<th>Caseworker</th>
<th>Foster provider/ Subcontractor</th>
<th>Participant name</th>
<th>Participant number</th>
<th>Service category</th>
<th>Service type</th>
<th>Service start date</th>
<th>Service end date</th>
<th>Rate per unit</th>
<th>Number of units</th>
<th>Invoiced amount</th>
<th>Service Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>3456782</td>
<td>123456</td>
<td>Alexander Dumas</td>
<td>Jill Faulkner</td>
<td>123456</td>
<td>Counseling and Therapeutic Services</td>
<td>Family Counseling</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>0.01</td>
<td>40000</td>
<td>$400.00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>333333</td>
<td>123456</td>
<td>Alexander Dumas</td>
<td>Jill Faulkner</td>
<td>123456</td>
<td>Counseling and Therapeutic Services</td>
<td>Family Counseling</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>0.01</td>
<td>40000</td>
<td>$400.00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>456777</td>
<td>345678</td>
<td>Charles Dickens</td>
<td>Mark Twain</td>
<td>787677</td>
<td>Residential Care - BRS Placement</td>
<td>BRS Shelter Eval Asst Hm - SRA</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>152.15</td>
<td>17</td>
<td>$2,586.55</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>888038</td>
<td>837667</td>
<td>James Joyce</td>
<td>Emily Dickinson</td>
<td>8877334</td>
<td>Strengthen, Preserve, Reunify Families</td>
<td>Navigators</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>0.01</td>
<td>20000</td>
<td>$200.00</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>888038</td>
<td>837667</td>
<td>James Joyce</td>
<td>Emily Dickinson</td>
<td>8877334</td>
<td>Strengthen, Preserve, Reunify Families</td>
<td>Navigators</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>0.01</td>
<td>20000</td>
<td>$200.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>400398</td>
<td>567830</td>
<td>Oscar Wilde</td>
<td>J.K. Rowling</td>
<td>567830</td>
<td>Residential Care - BRS Placement</td>
<td>BRS Shelter Eval Asst Hm - SRA</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>178.87</td>
<td>5</td>
<td>$894.35</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>400398</td>
<td>567830</td>
<td>Oscar Wilde</td>
<td>J.K. Rowling</td>
<td>567830</td>
<td>Residential Care Support Services</td>
<td>One-on-One Services</td>
<td>3/1/2014</td>
<td>3/30/2014</td>
<td>64.87</td>
<td>5</td>
<td>$324.35</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>686038</td>
<td>876335</td>
<td>Walt Whitman</td>
<td>Virginia Woolf</td>
<td>8877335</td>
<td>Strengthen, Preserve, Reunify Families</td>
<td>Client Emergency Fund</td>
<td>3/1/2014</td>
<td>3/15/2014</td>
<td>0.01</td>
<td>13000</td>
<td>$130.00</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>6783345</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
New Process: Payment Codes

Payment Codes will be used by DHS branch staff to indicate to OFS Contracts Payable that a invoice line may proceed or is not to be paid.

Code types:

- **VP: “Pay”** This indicates the invoice line has been completely validated at the branch level and is authorized for payment.
- **OP: “Pay (One-Time Payment)”** A different type of payment within the DHS system, but one that has been authorized and confirmed.
- **NP: “Do Not Pay.”** When an invoice line has been confirmed to be in error, to be outside the terms of the applicable contract, or, for any other reason, cannot be paid by DHS as invoiced, it will be coded as such.
New Process: Hold Codes

Hold Codes will be used whenever a payment line cannot be conclusively validated as either “Pay” or “Do Not Pay” within 5 business days.

By facilitating the tracking of challenging payment lines, DHS is freeing staff to authorize payment for those lines that are clearly valid, which translates to more rapid payment for providers.

Hold Codes tracked by branch staff:

- (AH) “Agency Hold”: Placements/services cannot be entered/validated and the BH hold reason does not apply.
- (CH) “Contract Hold”: A Contract is not available in OR-Kids for entry.
- (PH) “Provider Hold”: Inaccurate information on invoice/unable to confirm.

Hold Codes tracked by OFS staff:

- (BH): “BRS placement Hold” A contract or placements has not yet been entered and is in process.
DHS Child Welfare contracted providers can expect notice of the following:

- Invoice Submission/Receipt.

- Return of Invoice (DHS Branch to Provider) *(If necessary)*.
  - Why would we return?

- Submission of invoice by DHS branch to OFS Contracts payable within 5 business days.

- DHS branch lifting a hold on a prior submitted invoice.

- OFS Return of invoice to DHS branch *(If necessary)*.
WHAT IF HELP IS NEEDED?
5 & 5 is the goal DHS will strive to meet.

Fixed check run dates (Tues & Thursday nights) may impact payment timelines.

Who do I contact?

- If no email indicating sent to OFS, email branch invoice mailbox requesting status. If no response within 2 business days, contact branch office manager.

- If no payment but invoice sent to OFS, contact OFS (OFS-Contract.Invoices@state.or.us)

- Contract issues, contact Wellbeing BRS Program (Wellbeing.Contracts@state.or.us), or contract administrator listed on the contract.
DHS providers will be able to access an entire “tool kit” of resources on a re-designed site that will be accessible to those outside the DHS network. Providers will be able to easily:

- Locate/confirm branch submission emails
- Download a copy of the DHS invoice
- Receive computer-based training on completing the invoice
- Have FAQ’s answered.
- Receive guidance on the validation process
- Receive guidance on timelines for payment
- Understand DHS standards for returning or holding invoices.

http://www.oregon.gov/dhs/children/providers-partners/Pages/Contracting.aspx
PAYMENT AND RECONCILIATION
New Version Debuted in July 2014

- Sent with each check/EFT deposit.
- Vastly Improved Look and Detail
- Payments are sorted by:
  - Contract #
  - Service Type
  - Name
- Payment totals are sub-totaled by Service Type and Contract.
- Sub-providers are referenced.
- Adjustments are clearer and reference the sub-provider.
- Invoice available for provider use in December 2014
- Staff to begin new Invoicing Process in January 2015
- Staff training (Begun October 2014 and complete in December 2014)
- Provider training & CBT (Begun in November and complete in December 2014)
- Provider and Staff websites (December 2014)
The process described in the training has not yet been implemented and we are open to feedback before it debuts in January of 2015.

Please contact any of the listed presenters to provide your thoughts, concerns, or ideas prior to or after the implementation of this process.

Please tell us what you need!
REMEMBER

- 5 (field) & 5 (OFS) (two week goal for payment)

- Use the Invoice! Keep it electronic!

- Work with your contract administrators to ensure you’re getting what you need, including the information necessary to complete the invoice!

- Respond promptly to DHS branch requests for information/clarification.
Ask whatever you want!